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Introduction
The 
wifi2go
module integrates an ARM CortexM MCU and a WiFi processor together in an
OEM productionready form. This module was developed for rapid integration of WiFi capability
in user designs. Besides being OEM productionready, the w
ifi2goCarrier board version
is
also prototypingfriendly, where it can be used with a breadboard or other prototyping platforms.
For software development, 
wifi2go
is fully supported by ImageCraft’s JumpStart C for CortexM
C development tools and the JumpStart API. JumpStart C for CortexM includes a professional
IDE, a fast compiler, and easeofuse features not found in other C tools. The JumpStart API
makes it simple to access the peripherals of the microcontroller, but does not prevent users from
accessing the full power of the underlying hardware. With JumpStart API, programming the
peripherals of the powerful STM32F 32bit MCU is as easy as programming the peripherals of
an 8bit MCU.

wifi2go Module Features
●
●
●
●
●
●
●
●
●

Highperformance STM32F411 ARM CortexM4 with 512 KBytes of flash and 128
KBytes of SRAM running at 96Mhz
TI CC3100 for robust WiFi performance; it is the first device to be WiFi CERTIFIED™ at
the chip level
Low power requirements: under full WiFi, the module only consumes 200mA at 3.3V
Onboard chip antenna
A 2MByte serial flash for storing WiFi profiles and other configuration data
A 32KByte I2C EEPROM
External independent TI TPS3824 watchdog timer
RGB LED
Production programming using Tagconnect connector
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●
●

4 rows of SMD alignment holes for dropin production PCB assembly and pinout
connections
Physical dimensions: 35x45mm

Production Quantity Purchase Options
For production quantity purchases, the wifi2go module can be ordered in a number of
configurations:
●

●
●

Choice of ST ARM CortexM MCU: STM32F411 M4 (default: high performance),
STM32F070 (low cost). (A future version with STM32L series (low power) is in the
works.)
Choice of TI CC3100 or TI CC3100MOD  the latter allows the transfer of TI WiFi
Certification to the end user products.
UMC 50 Ohm RF connector for external antenna, instead of onboard antenna (default).

Support Boards
In addition being OEM productionready, additional wifi2go variants and support boards exist to
make prototyping and experimentation possible:
1. wifi2goCarrier
: the wifi2go module is soldered onto a small carrier board with the
following additional features:
○
○
○
○
○

For prototyping, all the pin connections on the wifi2go are brought out to header
pins
JTAG/SWD programming / debugging through industry standard 20pin header
An FTDItoUSB bridge chip and a miniUSB connector for virtual COM
communication with a Windows host
One reset and one user button
Special header for programming the CC3100 serial flash on the wifi2go
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2. wifi2goDevkit
: the devkit is a larger board than the carrier board, and is designed to
include most useful peripherals for standalone experimentation with the wifi2go.
Additional features beyond the basic wifi2go include:
○
○
○
○
○
○
○
○

2x12 OLED text/graphics LCD
microSD socket
RTC and battery holder
A FTDI to USB bridge chip and a miniUSB connector for virtual COM
communication with a Windows host
Second miniUSB connector connected to MCU’s native USB peripheral pins
JTAG/SWD programming / debugging through industry standard 20pin header
One reset and four user buttons
7 LEDs

3. DiskO addon
: a round board with connectors for the wifi2goCarrier header pins, the
DiskO board has 20 LEDs and is a lowcost and fun way to display output from the
wifi2gocarrier board.
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Terminology
AP 
 Access Point, e.g. a wireless router.
Gateway
 a node that on the LAN that can access the WAN.
IP
 Internet Protocol. However, per convention, IP can also refer to an IP address, e.g.
“192.168.10.1”
LAN
 Local Area Network. A network of nodes or devices.
RSSI
 Received Signal Strength Indicator. An indication of WiFi signal strength.
Socket
 An abstraction of an endpoint of a peertopeer communication connection.
SSID 
 Service Set Identifier. The name of an Access Point, e.g.: “Google Starbucks”
TCP/IP
 TCP stands for Transmission Control Protocol. TCP/IP is used commonly to refer to
the entire suite of internetworking communication protocols.
WAN
 Wide Area Network, i.e. remote network, such as the internet.
WiFi / WiFi
 A wireless LAN (WLAN) technology.
6
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Getting Started
To prototype your design and application code with wifi2go, you will need either the
wifi2goCarrier or the wifi2goDevkit board. Once you finalize your design, then you may
proceed to manufacturing using the wifi2go modules.

Installing JumpStart C for CortexM Compiler Software
You may download a 45day fully functional demo of JumpStart C for CortexM here:
https://imagecraft.com/download/demosoftware
. JumpStart API is part of the compiler
distribution.
There are programming examples for wifi2go installed under
c:\iccv8cortex\examples.wifi2go\
(replace c
:\iccv8cortex
with your install root).
Use the JumpStart C IDE and open the workspace under the directory to open the examples.
Please refer to the Help file (under the Help menu on the IDE, and also available on the
website: 
https://imagecraft.com/documentation/microboxandcortexmdocs
) for complete
documentation on the IDE and the compiler. While this IDE comes with many professional
features, it is also easy to use, so feel free to “play” with it!

JTAG/SWD Debug Pod
To download and debug programs onto the wifi2go, you will need a JTAG/SWD pod such as the
STLINK/V2 or Segger JLINK. For use with the wifi2goCarrier and wifi2goDevkit, a 20pin
straight ribbon connector (usually included with the pod) is used. For use with the wifi2go
module, you need a Tagconnect adaptor cable. To use the Tagconnect adapter, as there is no
space on the wifi2go for the 4 holes needed for the adapter gripping “feet”, you will need to
remove the “feet” from the adapter and just hold the adapter onto the board for programming.
ImageCraft offers a selection of these pods and cables for sale here:
https://imagecraft.com/index.php?option=com_opencart&Itemid=148&route=product/category&p
ath=64
When you connect the debug pod to Windows, it should automatically install the Windows
drivers. You can also find copies of the drivers in our JumpStart C for CortexM installation
under 
c:\iccv8cortex\
.
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Connecting a USB Cable Between the FTDI USB ridge and
Windows PC
The Carrier and the Devkit boards both have an FTDIUSB bridge chip onboard. You can
connect a USB cable between a PC and the miniUSB connector on the board (Note: on the
Devkit, where there are two miniUSB connectors, the lower one is connected to the FTDI chip),
and then use a terminal emulator for communication between the host PC and the UART of the
MCU. The USB cable also provides power to the wifi2go board. See Appendix B for details.

Carrier or Devkit Board Verification Programs
To verify that the MCU is functioning:
1. Connect a USB cable between the PC and the debug pod, and install the Windows
driver if you have not done so already.
2. Connect the 20pin JTAG/SWD cable between the debug pod and the wifi2go board.
3. Connect a USB cable between the PC and the FTDIUSB connector on the wifi2go
board. Install the FTDI driver if this has not been done earlier.
4. Run the JumpStart C for CortexM IDE.
5. Invoke File>Open, and browse to 
c:\iccv8cortex\examples.wifi2go\
open the
file 
example.workspace
.
6. Double click on the “LED Blink” project name on the left hand project file list pane to
make it the active project.
7. Invoke “Build>Build” to build the project.
8. Invoke “Project>Build options”, then switch to the “Debug/Download interface” tab and
make sure the correct debug pod is selected. Click OK.
9. Invoke “ImageCraft>Program Device with Project output”, and you should see a
download progress bar.
10. If everything is working correctly, then you should see the LED on the wifi2go change
from Red to Green to Blue, and the pattern will repeat.
To verify WiFi capability:
1. Make sure that there is an accessible wireless router close by.
2. With the example workspace open, double click on the “Wifi check” project name to
“WiFi Check” to make it active.
3. Open a terminal emulator program on your PC, and configure it to talk to the wifi2go
board. See Appendix B.
4. As above, build the project and download the output to the wifi2go board..
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5. Once the download finishes, on the terminal emulator window you should see a
message similar to “ImageCraft wifi2go running at 96 MHz. Trying to configure
CC3100…”
6. Follow the prompts on the terminal emulator and connect to the wireless router. The
program displays the IP address of the wifi2go module, then pings w
ww.google.com
,
displays its IP address, and then waits for user access.
7. Using a smartphone, tablet, or PC (wireless mode), make sure that it is on the same
wireless network as the wifi2go. Use a web browser and enter the wifi2go numeric IP
address shown in previous step, and you should see a welcome message displayed.
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Software Programming Guide
On the wifi2go module, the STM32F411 CortexM4 MCU runs the user application and the TI
CC3100 provides the WiFi functions.

Software Layers

ser Application
The user application accesses the STM32F411 primarily through the JumpStart API. Users may
also use ST’s StdPeriphLib or HAL functions directly if needed, as JumpStart API does not
expose all the features of the MCU.
All programming access to the TI CC3100 must go through the TI SimpleLink API. As in the
case for the STM MCU, we encapsulate some of the more commonlyused features into a set of
JumpStart API functions. The TI CC3100 is a very capable processor, and the JumpStart API
only covers a small set of (but some of the most important) features. To use the CC3100
effectively, you will need to install the TI CC3100 SDK and browse through the TI wiki site. See
Appendix A for details.
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JumpStart API
The design goal of the JumpStart API (Application Programming Interface) is to make it simple
to access the peripherals of the microcontroller without sacrificing the power specific to each
vendor’s hardware product. For general information on JumpStart API, visit
https://imagecraft.com/technologies/jumpstartapi
For wifi2go, JumpStart API has been expanded to include functions that interface with the TI
SimpleLink API. The source code for JumpStart API for the TI CC3100 has been released to
Open Source under the MIT License, and is available on Github, and also as part of the
JumpStart C for CortexM installation. The example workspace builds the source as part of a
project, but it can also be built as a library .
a 
file.
In the rest of this document, “JumpStart API” will refer only to the subset that sits on top of the
SimpleLink API.

Examples and Header File
To use the JumpStart API functions, you need to 
#include “cc3100.h”
in your source code
to include the function signatures and class declarations.
The simplest way to use the JumpStart API and the SimpleLink API is to link with the library
files. In the 
Project>Build Options, Target
tab, make sure the following appear in the
“Additional lib” edit box on the right hand side:
jsapistm32f4 jsapicc3100stm32f4
You may also include the source for the JumpStart API for the CC3100 and the TI SimpleLink
API in your project. See the example project “Wifi check” in the
c:\iccv8cortex\examples.wifi2go\examples.workspace
for an example. In that
case, make sure the “Additional lib” edit box only has j
sapistm32f4
in it.

Namespaces
Almost all of JumpStart API functions use the C++ Class object syntax for function access, e.g.
…
extern JSAPI_CC3100 cc3100;
cc3100.Init();
…
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cc3100.ConnectAP();
The JumpStart API defined classes and objects are declared in the header file cc3100.h:
typedef struct JSAPI_CC3100 { … } JSAPI_CC3100;
extern JSAPI_CC3100 cc3100;
typedef struct JS_CC3100_SOCKET { … ] JS_CC3100_SOCKET;
These are described in a later section of this document.
TI SimpleLink API functions and types start with the s
l_
prefix, so user programs should avoid
using that prefix.
Some ImageCraft interface functions to the SimpleLink API use the 
_cc3100_
prefix.
Generally, user program objects should not use names starting with the underscore _ character.

Future Enhancements
ImageCraft will continue to enhance JumpStart API to make SimpleLink firmware functionality
easier to use.
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JumpStart API: JSAPI_CC3100 Class
Note: Always refer to the header file cc3100.h for the latest function signatures and descriptions
This class definition and object provide the interface to the TI CC3100 device and basic
functionality.
typedef struct JSAPI_CC3100 {
// device function
int Init(void);
char *GetMACAddress(void);
int ConnectAP(const char *ssid, const char *key,
int security_type, int timeout);
int ScanSSID(void);
int Disconnect(void);
int GetHostByName(const char *host, unsigned *ip);
// Utility
int ResetDevice(void);
int Ping(uint32_t ip, int *rtt);
int IP_StrToInt(const char *strip, uint32_t *intip);
int IP_IntToStr(uint32_t intip, char *strip);
// DHCP obtained addresses, valid if ConnectAP succeeds
unsigned localIP;
unsigned gatewayIP;
// Known SSID, valid if ScanSSID succeeds
int known_num_ssid;
char ssid[MAX_NUM_OF_SSID][MAX_SSID_LENGTH];
int security_type[MAX_NUM_OF_SSID];
int rssi[MAX_NUM_OF_SSID];
} JSAPI_CC3100;
extern JSAPI_CC3100 cc3100;
An example code fragment may look like this:
#include <cc3100.h>
…
if (cc3100.Init())
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printf(“Cannot initialize CC3100\n”);
else if (cc3100.ConnectAP(“my router”, “mypassword”, 0, 0))
printf(“Cannot connect to AP\n”);
else
{
unsigned ip;
if (cc3100.GetHostByName(“
www.google.com
”, &ip) == 0)
{
int rtt;
if (cc3100.Ping(ip, &rtt) == 0)
printf(“Pinging Google took %dms\n”, rtt);
else
printf(“Cannot ping GOOGLE\n”);
}
else
printf(“Cannot resolve google.com”);
}

Return Values: 
most of these functions return 0 if success, and a negative number to indicate
failure. A number of failure codes are possible. Most of the time it happens because a call to the
SimpleLink API function fails. Refer to the JumpStart API source code for details.
int JSAPI_CC3100::Init(void);
Initializes the cc3100 device. No other functions should be called if this call fails.
char *GetMACAddress(void);
Returns a pointer to a static character array containing the MAC address in the form
XX:XX:XX:XX:XX:XX where each ‘X’ is a hexadecimal digit. Each (conformant) device has a
unique MAC address.
int JSAPI_CC3100::ConnectAP(const char *ssid, const char *key,
int security_type, int timeout);
Connects the CC3100 to an Access Point (AP). 
ssid
is the AP’s SSID, 
key
is the password,
security_type
is 0 (open network), 1 (WPA), or 2 (WEP or WPA). t
imeout 
is the timeout
value in seconds. The maximum timeout length the function will wait is 10 seconds.
If the call succeeds, then the following object members store the relevant information of the
connection:
unsigned localIP
is the IP of the CC3100 device, assigned by AP’s DHCP server.
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unsigned gatewayIP
is the IP of the WAN (Wide Area Network) gateway.
int JSAPI_CC3100::ScanSSID(void);
Scans for accessible APs. If successful, then the following object members of cc3100 store the
SSIDs:
int known_num_ssid
is the number of visible APs.
char ssid[MAX_NUM_OF_SSID][MAX_SSID_LENGTH]
is the array of the SSIDs.
Each SSID can be up to 
MAX_SSID_LENGTH
characters long.
int security_type[MAX_NUM_OF_SSID]
is the security type of each SSID. The
value is 0 (open), 1 (WPA), or 2 (WEP or WPA).
int rssi[MAX_NUM_OF_SSID]
is the signal strength of the AP.
int JSAPI_CC3100::Disconnect(void);
Disconnects from the AP.
int JSAPI_CC3100::GetHostByName(const char *host, unsigned *ip);
Resolves the IP of a host (e.g. “
www.google.com
”) by name. The host’s IP is written to the
unsigned integer pointed to by 
ip
.
int JSAPI_CC3100::ResetDevice(void);
Resets the CC3100 chip.
int JSAPI_CC3100::Ping(uint32_t ip, int *rtt);
Pings a host by its IP address. If success, the number of milliseconds it takes to ping the host is
written to the integer pointed to by 
rtt
.
int JSAPI_CC3100::IP_StrToInt(const char *strip, uint32_t *intip);
Converts a string representing an IP address of the form “A.B.C.D” where each letter represents
a decimal number from 0 to 255, to an unsigned integer pointed to by 
intip
.
int JSAPI_CC3100::IP_IntToStr(uint32_t intip, char *strip);
Converts an unsigned integer to a string of the form “A.B.C.D” where each letter represents a
decimal number from 0 to 255. 
strip
must be an array of characters of sufficient length, of at
least 16 bytes.
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JumpStart API: JS_CC3100_SOCKET Class
Note: Always refer to the header file cc3100.h for the latest function signatures and descriptions
Please see the supplied examples to see how these functions are used.
TI’s SimpleLink socket API is a classic implementation of the traditional Berkeley Unix style
socket, used for internet and interprocess communication. Once a connection is made between
two sockets, data can be sent between them.
The JumpStart API JS_CC3100_SOCKET class is a thin layer on top of the SimpleLink API,
eliminating some of the tedium in the SimpleLink usage.
typedef struct JS_CC3100_SOCKET {
int Open(int type); //type=0 > UDP, otherwise > TCP
int Bind(unsigned ip, unsigned port);
int Close(void);
int Connect(unsigned ip, unsigned port,
struct JS_CC3100_SOCKET *newsock);
int Listen(int qdepth);
int Accept(unsigned *ip, unsigned *port,
struct JS_CC3100_SOCKET *newsock);
int RecvFrom(unsigned ip, unsigned port,
unsigned char *buf, int *len);
int Recv(unsigned char *buf, int *len);
int SendTo(unsigned ip, unsigned port, unsigned char *buf,
int len);
int Send(unsigned char *buf, int len);
Int SocketNumber(void);
} JS_CC3100_SOCKET;
To use JS_CC3100_SOCKET class, you declare a variable of JS_CC3100_SOCKET type, and
then use the function 
Open
to assign a “socket number” to the variable.
JS_CC3100_SOCKET socket;
if (socket.Open(1))
{
printf(“Cannot create a new socket.\n”);
while(1)
;
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if (socket.Bind(0, 8080)) //Binds to all incoming addresses
{
printf("Bind Failed.\n");
socket.Close();
cc3100.Disconnect();
while(1)
;
}
if (socket.Listen(0))
{
printf("Listen Failed.\n");
socket.Close();
cc3100.Disconnect();
while(1);
}
printf("Socket created, waiting for incoming connections.\n");
Return Values: 
most of these functions return 0 if success, and a negative number to indicate
failure.
int Open(int type);
Assigns a socket number to the JS_CC3100_SOCKET object. This must be called to initialize
the object. 
type 
specifies the connection type, 0 is for UDP connection, and anything else
indicates TCP connection.
The function returns the socket number. The socket number may be retrieved at any time using
the 
SocketNumber()
function call.
int Bind(unsigned ip, unsigned port);
Binds the socket to an IP address and a port number. The port number 8080 means all
incoming connections.
int Close(void);
Closes the socket.
int Connect(unsigned ip, unsigned port, struct JS_CC3100_SOCKET
*newsock);
Connects to a remote peer with the given IP and port number. If successful, the socket object
pointed to by 
newsock
is initialized.
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int Listen(int qdepth);
Listens for incoming connections. q
depth
specifies the depth of the listening queue. This must
be called before 
Accept()
is called. For single thread application, q
depth
should be zero.
int Accept(unsigned *ip, unsigned *port, struct JS_CC3100_SOCKET
*newsock);
Accepts a connection request from the listening queue. If there is no pending connection
request, this function will wait until a connection request comes through.
The remote peer’s IP, its port number, and a newlyallocated socket number will be returned
through the objects pointed to by the three arguments to the function.
int RecvFrom(unsigned ip, unsigned port,
unsigned char *buf, int *len);
Receives a message from a remote peer with the given 
ip
address and p
ort
number. The
message is stored in the byte array b
uf
. On input, 
*len
contains the length of b
uf
, and on
output, the number of bytes in the received message is stored in 
*len
.
int Recv(unsigned char *buf, int *len);
Receives a message from a remote peer through a connection. The message is stored in the
byte array 
buf
. On input, 
*len
contains the length of b
uf
, and on output, the number of bytes
in the received message is stored in 
*len
.
int SendTo(unsigned ip, unsigned port, unsigned char *buf, int len);
Sends a message to a remote peer with the given IP and port number. The message is in the
byte array 
bu
f with 
len
bytes.
int Send(unsigned char *buf, int len);
Sends a message to a remote peer through a connection. The message is in the byte array b
u
f
with 
len
bytes.
int SocketNumber(void);
Returns the socket number of the socket object.
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Hardware Integration Guide
Basic Pinouts
The wifi2go module has been designed to be soldered directly to the top of the target hardware
with semicircular connections that have 2mm of spacing between the center of the holes. The
outline of the module is shown below. There are connections on all four sides, with the area for
the onboard chip antenna left free from connections and solder. See the module placement
section of this document for more details.
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MCU Pin Usage
The following MCU pins are used by the module:

STM32F Pins

CC3100

PA4

nHib (hibernation)

PA2

IRQ

PA3

RESET

PA5

SPI CLK

PA6

SPI MISO

PA7

SPI MOSI

PA8

SPI nCS

External Watchdog Timer
PD2

Watchdog signal. See text for description.

I2C Serial EEPROM
PB6

SCL

PB7

SDA

LEDs
PC7

Red

PC8

Green

PC9

Blue

FTDI UART>USB Bridge
(wifi2goCarrier, and wifi2goDevkit)
PA9

TX

PA10

RX
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Additional Onboard Hardware
External TI TPS3824 Watchdog Timer
PD2 is connected to the external watchdog timer. If you do not want to enable the external
watchdog, set PD2 as INPUT:
#include <jsapi.h>
…
portd.MakeInput(2);
Otherwise, set it as output, pulled low, and send a pulse every 1.9 milliseconds or less. Note: to
be most effective, do not generate the watchdog pulse in an interrupt handler, as it is intended
to indicate that the user application is working:
portd.MakeOutput(2, OSPEED_HIGH);
portd.SetPullUpDown(2, PUPDR_DOWN);
…
// Pulse PD2
portd.Set(2);
// short delay
for (int i = 0; i < 10; i++)
;
portd.Clear(2);
See TPS3834 datasheet for further details.

LED
There is a single RGB LED on the wifi2go module. Red is connected to PC7, Green to PC8, and
Blue to PC9. The LED may be removed if you wish to use the GPIO for other purposes.

32KByte I2C Serial EEPROM
There is a 32KByte Serial EEPROM (Microchip 24AA256) onbroad, attached to the I2C bus .
The I2C bus uses PB6/PB7 for SCL/SDA respectively. The 7bit I2C address is 0b1010000 or
0x50. Please see the supplemental device datasheet for more details.
Additional user I2C devices might be attached to the same bus as the pins are brought out to
CN3.12 and CN3.13 (see below).
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2MByte CC3100 Companion Serial Flash
The TI CC3100 requires a serial flash for storing configuration and other data, in order for it to
function fully. wifi2go includes a 2MByte flash (Winbond W25Q16DVSNIG) for this purpose. It
is properly initialized, and application code may access it using the SimpleLink File System API.
You may program the flash (e.g. with prestored configuration data or web page contents) by
using a special adaptor board that connects to the four TI CC3100 UART pins (which are
brought out to CN4.5 to CN4.8). See Appendix C for details.

JTAG/SWD Programing Header
The wifi2go module has a 10pin JTAG/SWD programming header for programming the
STM32F MCU. You will need a JTAG/SWD pod such as the Segger JLINK or the STLINK/V2,
and a Tagconnect adapter to attach the pod to the wifi2go header.
On the wifi2goCarrier and wifi2goDevit boards, a full size 20pin JTAG/SWD connector is
available so a simple 20pin ribbon cable can be used.

FTDI UARTUSB Bridge (wifi2go Carrier or Devkit board)
On the wifi2goCarrier and wifi2goDevit boards, PA9 and PA10 are brought out to interface with
the FTDIUSB bridge. To write to the UART using JumpStart API is as simple as:
usart1.SetPins(&porta, 9, 7, &porta, 10, 7);
usart1.MakeUSART(9600, 8, 1, true);
printf("Hello World\n");
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Connections and Signals
Note that if another STM32 MCU is used instead of the default STM32F411RE, the pinouts
might be slightly different due to the availability of certain pins.
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CN1, left edge
(20 pins, top to bottom)

STM32F411 Pins

1

PC0

2

PC1

3

PC2

4

PC3

5

RESET

6

PA0

7

PA1

8

PC4

9

PC5

10

PB0

11

PB1

12

PB2

13

PB10

14

PB11

15

PB8

16

PB9

17

PD2 (external watchdog timer, see previous section)

18

GND

19

GND

20

GND

CN2, right edge
(15 pins, top to bottom)

STM32F411 Pins

1

PB12
25

2

PB13

3

PB14

4

PB15

5

PA9

6

PA11

7

PA12

8

PA10

9

PC6

10

Vcc

11

PC7 (Red LED)

12

PC8 (Green LED)

13

PC9 (Blue LED)

14

JNTRST

15

JTMS

CN3, top edge
(15 pins, right to left)

STM32F411 Pins

1

JTDI

2

JTCK

3

JTDO

4

PC10

5

PC11

6

PC12

7

PC13

8

PC14

9

PC15
26

10

PB4

11

PB5

12

PB6

13

PB7

14

BOOT0

15

GND

CN4, bottom edge
(10 pins, left to right)

STM32F411/CC3100 Pins

1

PA15

2

Vcc

3

Vcc

4

Vcc

5

CC3100 UART1 nRTS

6

CC3100 UART1 nCTS

7

CC3100 UART1 RX

8

CC3100 UART1 TX

9

GND

10

GND

(Note that CN3 is labelled right to left whereas CN4 is labelled left to right)

Module location on Target hardware and Assembly Instructions
For production, the wifi2go module is soldered directly onto the application PCB. The simple
lowcost solution of soldering to the target hardware provides the lowest cost assembly and also
the best possible reliability, as there are no connectors involved. The wifi2go module has three
1mm alignment holes. During assembly, three 1mm alignment pins can be placed in these holes
to match the holes in the target hardware; then the module can be soldered to the target
hardware and the alignment pins removed.
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When designing the target hardware, the module is best placed with the chip antenna on the
edge of the PCB, and there should be no ground plane or copper located in the area of the chip
antenna. If an external antenna is used with the UMC RF connector, the module location is less
critical, but always keep the PCB area around the RF connector free from copper.
The wifi2gocarrier is an example of incorporating the wifi2go module into another board design.
However, note that since wifi2gocarrier is meant for wifi2go evaluation, and that we wanted to
keep the board dimensions to a reasonable size and shape, the chip antenna was not placed at
the edge of the carrier board. As mentioned above, this should NOT be done in your production
design.

28

Appendix A TI CC3100 Documentation
TI CC3100 Wiki
These web pages:
http://www.ti.com/ww/en/simplelink_embedded_wifi/cc3100.html
http://processors.wiki.ti.com/index.php/CC31xx_Programmers_Guide
are good starting points for learning about the TI CC3100 and the SimpleLink API

TI CC3100 SDK
The TI CC3100 SDK is available from h
ttp://www.ti.com/tool/CC3100SDK
. Besides containing
the source and documentation for the SimpleLink API, it contains numerous examples on using
the CC3100. To effectively use the CC3100 device, please browse the TI web sites mentioned
and the SDK documentation.

TI SimpleLink API
The SimpleLink API defines the interface to the CC3100 firmware. There are six set of APIs:
●
●
●
●
●
●

Device  manages hardware devices
WLAN  manages WLAN, 802.11 protocols
Socket  BSD Socket API for user applications
NetApp  provides networking services such as HTTP, DHCP etc.
NetCfg  provides network configurations such as MAC addresses, manages DHCP IP
addresses, etc.
File System  provides access to the serial flash attached to the CC3100, which is
required for storing networking and user data

TI supplies the SimpleLink API Host Driver in source form, and it can be compiled together with
the user application for the MCU. ImageCraft has done this port, and ensured that the
SimpleLink API interface is working properly using JumpStart C for CortexM.

OS vs. SingleThread Port of SimpleLink Host Driver
This port of the SimpleLink API host driver uses the singlethread model where a call into the
SimpleLink API does not return (from the TI CC3100 firmware) until the operation is finished. If
you are using a preemptive multitasking executive such as ImageCraft’s NanoExec, and if only
one thread will interact with the TI CC3100, then you may continue to use this port.
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Otherwise, you will need to port the host driver under the multithread / OS model. Please see
the TI CC3100 SDK for details.
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Appendix B: FTDI Virtual Com
On the wifi2goCarrier and wifi2goDevit boards, PA9 and PA10 are brought out to interface with
the FTDIUSB bridge. When you connect a USB cable between the board and the Windows PC
(on the Devkit, there are two miniUSB connector, the FTDIUSB bridge connector is the lower
position one), Windows will install the FDTI driver. A copy of the driver is also included in the
JumpStart C installation.
After you install the FTDI driver, the FTDI port will appear as a virtual COM port on the PC. You
may then use a PC terminal program such as PuTTY or Hyperterminal to communicate with the
wifi2go module. Characters received from the wifi2go will be display on the terminal, and
keystrokes entered on the terminal will be sent to the wifi2go.
We recommend using PuTTY as the terminal emulator, since it is a small program and simple to
set up. From the program’s website: 
http://www.chiark.greenend.org.uk/~sgtatham/putty/
:
PuTTY is a free implementation of Telnet and SSH for Windows and Unix platforms,
along with an xterm terminal emulator. It is written and maintained primarily by
Simon
Tatham
.
Installing PuTTY: please visit the site
http://www.chiark.greenend.org.uk/~sgtatham/putty/
and
click on the download link, or click on the direct download link:
http://the.earth.li/~sgtatham/putty/latest/x86/putty.exe
Click on the download file to run and install the program.

Finding Out the COM Port Number
To use a terminal emulator with the wifi2go VCOM port, first you must find out the com port
number:
1. Open the Control Panel on your computer, then invoke the Device Manager, or
2. Click on Run or Search at the Start button, and enter devmgmt.msc.
3. Click on the “Ports (COM & LPT)” entry, and you should see an entry for the FTDI
device. Note the com port number.

Setting Up PuTTY
Invoke PuTTY, then click on the word “Serial” on lower left:
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This opens the serial line options dialog:
1. Enter the com port number in the “Serial line to connect to” field. Note: it must be in the
form of COM#.
2. Speed should be set to the same baudrate as you use in your application (9600 in this
case), Data bits: 8, Parity: None. Flow Control should be either None or RTS/CTS.
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Appendix C Using Uniflash
The serial flash attached to the CC3100 is used for WiFi profile storage, but it can also hold any
files you want, including web pages. The following is the list of steps you need to do:
1. Program the “wifi2goUniflashAssist” program into the wifi2go module. This program is
in the c:\iccv8cortex\examples.wifi2go directory
2. Attach a FTDI serial / TTL to USB cable between the wifi2go module and the PC and
install the FTDI driver
3. Download the install TI’s Uniflash software
4. Run Uniflash
To program the serial flash, you need to access the UART pins on the CC3100 and use TI’s
software Uniflash. Uniflash can be downloaded from TI’s site. Please do a web search to find its
location. Download and install, and read the operating procedures. The most relevant
information to the wifi2go tasks are described below.
CC3100’s TX/RX are brought to CN4.7 and CN4.8. On the wifi2go module, you will need a
special jig to access the pins. On the wifi2goCarrier board, the pins are brought out to the P6
connector. You need a TTL/serial to USB cable (we recommend cables using FTDI chips) to
connect P6 to the USB port to the PC. When you plug in the FTDI cable to the PC, Windows will
install the driver and create a virtual COM port. Use the Windows Device Manager, click on
“Ports” and find the COM port number for your FTDI cable.
Start Uniflash, invoke “File>New Configuration” and select “CC3x..” in the Connection list and
the “Simplelink Wifi…” in the “Board or Device” box. Enter the COM port number in the Uniflash
“COM Port” box.
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The serial flash on the wifi2go is 2 Mbytes, and if you reformat the flash, you must tell Uniflash
the correct size of the flash.
With the “wifi2goUniflashAssist” running on the wifi2go, run Uniflash’s command (e.g.: Get
Version) and look at the console output at the bottom.

When it says “INFO:  please restart the device ”, press the S2 button on the wifi2go module
(the specific button will be different if you are using different wifi2go boards, and the specific can
be changed by modifying the “wifi2goUniflashAssist” project). This will reset the CC3100 and it
will start communicating with Uniflash.
To add files, e.g. web page, to the serial flash, please see Uniflash’s documentation for details.
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Appendix D WiFi Certifications
The end user products using wifi3go MUST be certified by the respective governing agency. In
the USA, this is the FCC. TI’s document SWRA458A  “Transfer of Texas Instrument’s WiFi
Alliance Certification to Your CC3x00 Product”, application report from TI explains some basic
information.
TI CC3100 is “chiplevel Certified”, and the Certification cannot be transferred to the end user
products. However, a related product, CC3100MOD, allows such transfer. For quantity purchase
of wifi2go, you may order the modules with the CC3100MOD option, or you may proceed to
obtain your own WiFi Certification.
For more information, please visit 
http://wifi.org
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Appendix E
Product Design Consultation
wifi2go
provides both the core hardware and software solutions for your IoT designs.
Additionally, ImageCraft provides consulting services for both hardware and software design to
assist you in the rapid integration of wifi2go with your products; helping to reduce your time to
market even further. If you would like our assistance, please email us with your requests, and
we will be happy to provide you with a competitive quote.

On the Web
Information about the wifi2go can be found here:
http://imagecraft.com/wifi2go

About Us
wifi2go is a product of 
ImageCraft
. The modules can be purchased from ImageCraft h
ere
. The
hardware is designed through a partnership with E
xtron Design Services
. Please direct all
support questions to 
support@imagecraft.com
and all other questions to i
nfo@imagecraft.com
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Additional Documentation
The following schematics and datasheets are included in the documentation set:
●
●
●
●
●
●
●
●
●
●

wifi2go schematic
wifi2gocarrier schematic
wifi2gocarrier board layout
ST STM32F411 MCU reference manual
ST STM32F411 MCU data sheet
TI CC3100 WiFi processor user guide
TI CC3100 WiFi processor data sheet
TI SWRA458A  “Transfer of Texas Instrument’s WiFi Alliance Certification to Your
CC3x00 Product”, application report
TI TPS3824 watchdog data sheet
Microchip 24AA256 EEPROM data sheet
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